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2. Customizing Internal Memory IP Cores
Installing and Licensing IP Cores
The Quartus II software includes the Altera IP Library. The library provides many 
useful IP core functions for production use without additional license. You can fully 
evaluate any licensed Altera IP core in simulation and in hardware until you are 
satisfied with its functionality and performance. 

Some Altera IP cores, such as MegaCore® functions, require that you purchase a 
separate license for production use. After you purchase a license, visit the Self Service 
Licensing Center to obtain a license number for any Altera product. For additional 
information, refer to Altera Software Installation and Licensing.

1 The default installation directory on Windows is <drive>:\altera\<version number>; 
on Linux it is <home directory>/altera/<version number>.

IP Catalog and Parameter Editor
The Quartus II IP Catalog (Tools > IP Catalog) and parameter editor help you easily 
customize and integrate IP cores into your project. You can use the IP Catalog and 
parameter editor to select, customize, and generate files representing your custom IP 
variation.

The IP Catalog automatically displays the IP cores available for your target device. 
Double-click any IP core name to launch the parameter editor and generate files 
representing your IP variation. The parameter editor prompts you to specify your IP 
variation name, optional ports, architecture features, and output file generation 
options. The parameter editor generates a top-level .qsys or .qip file representing the 
IP core in your project. Alternatively, you can define an IP variation without an open 
Quartus II project. When no project is open, select the Device Family directly in IP 
Catalog to filter IP cores by device.

1 The IP Catalog is also available in Qsys (View > IP Catalog). The Qsys IP Catalog 
includes exclusive system interconnect, video and image processing, and other 
system-level IP that are not available in the Quartus II IP Catalog.

Use the following features to help you quickly locate and select an IP core:

■ Filter IP Catalog to Show IP for active device family or Show IP for all device 
families.

Figure 2–1. IP core Installation Path
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ip - Contains the Altera IP Library and third-party IP cores

altera - Contains the Altera IP Library source code
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2–2 Chapter 2: Customizing Internal Memory IP Cores
■ Search to locate any full or partial IP core name in IP Catalog. Click Search for 
Partner IP, to access partner IP information on the Altera website.

■ Right-click an IP core name in IP Catalog to display details about supported 
devices, installation location, and links to documentation.

1 The IP Catalog and parameter editor replace the MegaWizard™ Plug-In Manager in 
the Quartus II software. The Quartus II software may generate messages that refer to 
the MegaWizard Plug-In Manager. Substitute “IP Catalog and parameter editor” for 
“MegaWizard Plug-In Manager” in these messages.

Using the Parameter Editor
The parameter editor helps you to configure your IP variation ports, parameters, 
architecture features, and output file generation options:

■ Use preset settings in the parameter editor (where provided) to instantly apply 
preset parameter values for specific applications.

■ View port and parameter descriptions and links to detailed documentation.

Figure 2–2. Quartus II IP Catalog
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■ Generate testbench systems or example designs (where provided).

Customizing and Generating IP Cores
You can customize IP cores to support a wide variety of applications. The Quartus II 
IP Catalog displays IP cores available for the current target device. The parameter 
editor guides you to set parameter values for optional ports, features, and output files. 

To customize and generate a custom IP core variation, follow these steps: 

1. In the IP Catalog (Tools > IP Catalog), locate and double-click the name of the IP 
core to customize. The parameter editor appears.

2. Specify a top-level name for your custom IP variation. This name identifies the IP 
core variation files in your project. If prompted, also specify the target Altera 
device family and output file HDL preference. Click OK.

3. Specify the desired parameters, output, and options for your IP core variation:

■ Optionally select preset parameter values. Presets specify all initial parameter 
values for specific applications (where provided).

■ Specify parameters defining the IP core functionality, port configuration, and 
device-specific features.

■ Specify options for generation of a timing netlist, simulation model, testbench, 
or example design (where applicable).

■ Specify options for processing the IP core files in other EDA tools.

4. Click Finish or Generate to generate synthesis and other optional files matching 
your IP variation specifications. The parameter editor generates the top-level .qip 
or .qsys IP variation file and HDL files for synthesis and simulation. Some IP cores 
also simultaneously generate a testbench or example design for hardware testing.

Figure 2–3. IP Parameter Editors

View IP port
and parameter 
details
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2–4 Chapter 2: Customizing Internal Memory IP Cores
When you generate the IP variation with a Quartus II project open, the parameter 
editor automatically adds the IP variation to the project. Alternatively, click Project > 
Add/Remove Files in Project to manually add a top-level .qip or .qsys IP variation 
file to a Quartus II project. To fully integrate the IP into the design, make appropriate 
pin assignments to connect ports. You can define a virtual pin to avoid making 
specific pin assignments to top-level signals.

Upgrading Outdated IP Cores
Altera IP cores have a version number that corresponds with the Quartus II software 
version. The Quartus II software alerts you when your IP core is outdated with 
respect to the current Quartus II software version. Click Project > Upgrade IP 
Components to easily identify and upgrade outdated IP cores.

You are prompted to upgrade IP when the new version includes port, parameter, or 
feature changes. You are also notified if IP is unsupported or cannot be migrated in 
the current software. Most Altera IP cores support automatic simultaneous upgrade, 
as indicated in the GUI. IP cores unsupported by auto upgrade require regeneration in 
the parameter editor.

To upgrade outdated IP cores in your design, follow these steps:

1. In the latest version of the Quartus II software, open the Quartus II project 
containing an outdated IP core variation.

2. Click Project > Upgrade IP Components. The Upgrade IP Components dialog 
box displays all outdated IP cores in your project, along with basic instructions for 
upgrading each core.

3. Upgrading IP cores changes your original design files. To preserve these original 
files, click Project > Archive and save a project archive preserving your original 
files.

4. To simultaneously upgrade all IP cores that support automatic upgrade, click 
Perform Automatic Upgrade. The IP variation upgrades to the latest version.

5. To upgrade IP cores unsupported by automatic upgrade, select the IP core in 
Upgrade IP Components dialog box, and then click Upgrade in Editor. The 
parameter editor appears. Click Finish or Generate to regenerate the IP variation 
and complete the upgrade. The version number updates when complete.

Figure 2–4. Upgrading Outdated IP Cores
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in the Project
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1 Altera verifies that the current version of the Quartus II software compiles the 
previous version of each IP core. The MegaCore IP Library Release Notes and Errata 
reports any verification exceptions. Altera does not verify compilation for IP cores 
older than the previous release.

Alternatively, you can upgrade IP cores at the command line. To upgrade a single IP 
core: 

quartus_sh --ip_upgrade -variation_files <variation_file_path> <project>

To upgrade a list of IP cores:

quartus_sh --ip_upgrade -variation_files 
<variation_file_path>;<qsys_file_path>;<variation_file_path> <project>

1 File paths must be relative to the project directory and you must reference 
the IP variation .v or .vhd file or .qsys file, not the .qip file.
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3. Parameter Settings
This section describes the parameter settings for the memory modes.

1 You can use the IP Catalog (Tools > IP Catalog) and parameter editor to define and 
generate valid RAM and ROM memory blocks.

Table 3–1 lists the parameter settings for the RAM:1-Port.

Table 3–1. RAM:1-Port Parameter Settings

Option Legal Values Default 
value Description

Parameter Settings: Widths/Blk Type/Clks

How wide should the ‘q’ output bus be? — 8

Specifies the width of the ‘q’ output 
bus.

For more information, refer to “Port 
Width Configuration” on page 4–7.

How many <X>-bit words of memory? — 256 Specifies the number of <X>-bit words.

What should the memory block type be?

Auto, M-RAM, M4K, 
M512, M9K, M10K, 

M144K, MLAB, 
M20K, LCs

Auto

Specifies the memory block type. The 
types of memory block that are 
available for selection depends on your 
target device. 

For more information refer to “Memory 
Block Types” on page 4–4.

Set the maximum block depth to 

Auto, 32, 64, 128, 
256, 512, 1024, 

2048, 4096, 
8192,16384, 32768, 

65536

Auto

Specifies the maximum block depth in 
words.

For more information refer to 
“Maximum Block Depth Configuration” 
on page 4–9.

What clocking method would you like to 
use?

Single clock 

or

Dual Clock: use 
separate ‘input’ and 

‘output’ clocks

Single clock

Specifies the clocking method to use.

Single clock—A single clock and a 
clock enable controls all registers of the 
memory block.

Dual Clock: use separate ‘input’ and 
‘output’ clocks—An input and an 
output clock controls all registers 
related to the data input and output 
to/from the memory block including 
data, address, byte enables, read 
enables, and write enables.

For more information, refer to 
“Clocking Modes and Clock Enable” on 
page 4–10.
Internal Memory (RAM and ROM)
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Parameter Settings: Regs/Clken/Byte Enable/Aclrs

Which ports should be registered?

The following options are available:

■ ‘data’ and ‘wren’ input ports

■ ‘address’ input port

■ ‘q’ output port

On/Off On Specifies whether to register the input 
and output ports.

Create one clock enable signal for each 
clock signal. Note: All registered ports are 
controlled by the enable signal(s)

On/Off Off
Specifies whether to turn on the option 
to create one clock enable signal for 
each clock signal. 

More Options

Use clock enable for 
port A input 
registers

On/Off Off Specifies whether to use clock enable 
for port A input registers.

Use clock enable for 
port A output 
registers

On/Off Off Specifies whether to use clock enable 
for port A output registers.

Create an 
‘addressstall_a’ 
input port.

On/Off Off

Specifies whether to create a 
addressstall_a input port. You can 
create this port to act as an extra active 
low clock enable input for the address 
registers.

For more information, refer to “Address 
Clock Enable” on page 4–12.

Create byte enable for port A On/Off Off

Specifies whether to create a byte 
enable for port A. Turn on this option if 
you want to mask the input data so that 
only specific bytes, nibbles, or bits of 
data are written.

For more information, refer to “Byte 
Enable” on page 4–13.

What is the width of a byte for byte 
enables?

MLAB: 5 or 10
Other memory block 
types: 8 or 9

M10K and M20K: 8, 
9, or 10

MLAB: 5
Other 

memory 
block types: 

8

Specifies the byte width of the byte 
enable port. The width of the data input 
port must be divisible by the byte size.

For more information, refer to “Byte 
Enable” on page 4–13.

Create an ‘aclr’ asynchronous clear for the 
registered ports. On/Off Off

Specifies whether to create an 
asynchronous clear port for the 
registered data, wren, address, q, 
and byteena_a ports.

For more information, refer to 
“Asynchronous Clear” on page 4–14.

More Options ‘q’ port On/Off Off

Turn on this option for the ‘q’ port to be 
affected by the asynchronous clear 
signal.

The disabled ports are not affected by 
the asynchronous clear signal.

Table 3–1. RAM:1-Port Parameter Settings

Option Legal Values Default 
value Description
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Chapter 3: Parameter Settings 3–3
Create a ‘rden’ read enable signal On/Off Off

Specifies whether to create a read 
enable signal.

For more information, refer to “Read 
Enable” on page 4–15.

Parameter Settings: Read During Write Option

What should the q output be when reading 
from a memory location being written to?

New data, Don’t 
Care New data

Specifies the output behavior when 
read-during-write occurs.

New Data—New data is available on 
the rising edge of the same clock cycle 
on which it was written.

Don’t Care—The RAM outputs “don't 
care” or “unknown” values for 
read-during-write operation.

For more information, refer to “Read-
During-Write” on page 4–16.

Get x’s for write masked bytes instead of 
old data when byte enable is used On/Off On

Turn on this option to obtain ‘X’ on the 
masked byte.

For M10K and M20K memory block, 
this option is not available if you 
specify New Data as the output 
behavior when RDW occurs.

Parameter Settings: Mem Init

Do you want to specify the initial content 
of the memory?

No, leave it blank 

or

Yes, use this file for 
the memory content 

data

No, leave it 
blank

Specifies the initial content of the 
memory.

To initialize the memory to zero, select 
No, leave it blank.

To use a memory initialization file 
(.mif) or a hexadecimal (Intel-format) 
file (.hex), select Yes, use this file for 
the memory content data.

For more information, refer to “Power-
Up Conditions and Memory 
Initialization” on page 4–18.

Allow In-System Memory Content Editor to 
capture and update content independently 
of the system clock

On/Off Off

Specifies whether to allow In-System 
Memory Content Editor to capture and 
update content independently of the 
system clock.

The ‘Instance ID’ of this RAM is — None Specifies the RAM ID.

Table 3–1. RAM:1-Port Parameter Settings

Option Legal Values Default 
value Description
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Table 3–2 lists the parameter settings for the RAM:2-Port.
 

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description

Parameter Settings: General 

How will you be using the dual port RAM?

With one read port and 
one write port 

or

With two read /write 
ports

With one 
read port 
and one 

write port

Specifies how you use the dual 
port RAM.

How do you want to specify the memory size?

As a number of words

or

As a number of bits

As a 
number of 

words

Determines whether to specify 
the memory size in words or bits.

Parameter Settings: Widths/ Blk Type

How many <X>-bit words of memory? — 256 Specifies the number of <X>-bit 
words.

Use different data widths on different ports On/Off Off Specifies whether to use different 
data widths on different ports.

When you select With one read port and one 
write port, the following options are available:

■ How wide should the ‘q_a’ output bus be?

■ How wide should the ‘data_a’ input bus be?

■ How wide should the ‘q’ output bus be? — 8

Specifies the width of the input 
and output ports.

For more information, refer to 
“Port Width Configuration” on 
page 4–7.

When you select With two read/write ports, 
the following options are available:

■ How wide should the ‘q_a’ output bus be?

■ How wide should the ‘q_b’ output bus be?

What should the memory block type be?

Auto, M-RAM, M4K, 
M512, M9K, M10K, 

M144K, MLAB, M20K, 
LCs

Auto

Specifies the memory block type. 
The types of memory block that 
are available for selection 
depends on your target device.

For more information refer to 
“Memory Block Types” on 
page 4–4.

How should the memory be implemented?

Use default logic cell 
style 

or 

Use Stratix M512 
emulation logic cell 

style

Use 
default 

logic cell 
style 

Specifies the logic cell 
implementation options. This 
option is enabled only when you 
choose LCs memory type.
Internal Memory (RAM and ROM) June 2014 Altera Corporation
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Set the maximum block depth to Auto, 32, 64, 128, 256, 
512, 1024, 2048, 4096 Auto

Specifies the maximum block 
depth in words. This option is 
enabled only when you set the 
memory block type to Auto.

For more information refer to 
“Maximum Block Depth 
Configuration” on page 4–9.

Parameter Settings: Clks/Rd, Byte En

What clocking method would you like to use?

When you select With 
one read port and one 
write port, the following 
values are available:

■ Single clock 

■ Dual clock: use 
separate ‘input’ and 
‘output’ clocks

■ Dual clock: use 
separate ‘read’ and 
‘write’ clock

When you select With 
two read/write ports, the 
following options are 
available:

■ Single clock 

■ Dual clock: use 
separate ‘input’ and 
‘output’ clocks

■ Dual clock: use 
separate clocks for A 
and B ports

Single 
clock

Specifies the clocking method to 
use.

Single clock—A single clock and 
a clock enable controls all 
registers of the memory block.

Dual Clock: use separate ‘input’ 
and ‘output’ clocks—An input 
and an output clock controls all 
registers related to the data input 
and output to/from the memory 
block including data, address, 
byte enables, read enables, and 
write enables.

Dual clock: use separate ‘read’ 
and ‘write’ clock—A write clock 
controls the data-input, write-
address, and write-enable 
registers while the read clock 
controls the data-output, read-
address, and read-enable 
registers.

Dual clock: use separate clocks 
for A and B ports—Clock A 
controls all registers on the port 
A side; clock B controls all 
registers on the port B side. Each 
port also supports independent 
clock enables for both port A and 
port B registers, respectively.

For more information, refer to 
“Clocking Modes and Clock 
Enable” on page 4–10.

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
June 2014 Altera Corporation Internal Memory (RAM and ROM)
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3–6 Chapter 3: Parameter Settings
When you select With one read port and one 
write port, the following option is available:

Create a ‘rden’ read enable signal

— Off

Specifies whether to create a 
read enable signal for port B.

For more information, refer to 
“Read Enable” on page 4–15.

When you select With two read/write ports, 
the following option is available:

Create a ‘rden_a’ and ‘rden_b’ read enable 
signal

Specifies whether to create a 
read enable signal for port A and 
B. 

For more information, refer to 
“Read Enable” on page 4–15.

Create byte enable for port A

— Off

Specifies whether to create a 
byte enable for port A and B. 
Turn on these options if you want 
to mask the input data so that 
only specific bytes, nibbles, or 
bits of data are written.

The option to create a byte 
enable for port B is only available 
when you select two read/write 
ports.

For more information, refer to 
“Byte Enable” on page 4–13.

Create byte enable for port B

Enable error checking and correcting (ECC) to 
check and correct single bit errors and detect 
double errors

On/Off Off

Specifies whether to enable the 
ECC feature that corrects single 
bit errors and detects double 
errors at the output of the 
memory.

This option is only available in 
devices that support M144K 
memory block type.

For more information, refer to 
“Error Correction Code” on 
page 4–19.

Enable error checking and correcting (ECC) to 
check and correct single bit errors, double 
adjacent bit errors, and detect triple adjacent 
bit errors

On/Off Off

Specifies whether to enable the 
ECC feature that corrects single 
bit errors, double adjacent bit 
errors, and detects triple 
adjacent bit errors at the output 
of the memory.

This option is only available in 
devices that support M20K 
memory block type.

For more information, refer to 
“Error Correction Code” on 
page 4–19.

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
Internal Memory (RAM and ROM) June 2014 Altera Corporation
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Parameter Settings: Regs/Clkens/Aclrs

Which ports should be registered?

When you select With one read port and one 
write port, the following options are available:

■ ‘data’, ‘wraddress’, and ‘wren’ write input 
ports

■ ‘raddress’ and ‘rden’ read input port

■ Read output port(s) ‘q’ 

When you select With two read/write ports, 
the following options are available:

■ ‘data_a’, ‘wraddress_a’, and ‘wren_a’ write 
input ports

■ Read output port(s) ‘q’_a and ‘q_b’

On/Off On
Specifies whether to register the 
read or write input and output 
ports.

More Options

When you select 
With one read port 
and one write port, 
the following 
options are 
available:

■ ‘data’ port

■ ‘wraddress’ port

■ ‘wren’ port

■ ‘raddress’ port

■ ‘q_b’ port

When you select 
With two read 
/write ports, the 
following options 
are available:

■ ‘data_a’ port

■ ‘data_b’ port

■ ‘wraddress_a’ 
port

■ ‘wraddress_b’ 
port

■ ‘wren_a’ port

■ ‘wren_b’ port

■ ‘q_a’ port

■ ‘q_b’ port

On/Off On

The read and write input ports 
are turned on by default. You 
only need to specify whether to 
register the Q output ports.

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
June 2014 Altera Corporation Internal Memory (RAM and ROM)
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3–8 Chapter 3: Parameter Settings
Create one clock enable signal for each clock 
signal. On/Off Off

Specifies whether to turn on the 
option to create one clock enable 
signal for each clock signal.

For more information, refer to 
“Clocking Modes and Clock 
Enable” on page 4–10.

More Options

When you select 
With one read port 
and one write port, 
the following 
option is available:

Use clock enable 
for write input 
registers

When you select 
With two read 
/write ports, the 
following options 
are available:

■ Use clock 
enable for port A 
input registers

■ Use clock 
enable for port B 
input registers

■ Use clock 
enable for port A 
output registers

■ Use clock 
enable for port B 
output register

On/Off Off

Clock enable for port B input and 
output registers are turned on by 
default. You only need to specify 
whether to use clock enable for 
port A input and output registers. 

For more information, refer to 
“Clocking Modes and Clock 
Enable” on page 4–10

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
Internal Memory (RAM and ROM) June 2014 Altera Corporation
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More Options

When you select 
With one read port 
and one write port, 
the following 
options are 
available:

■ Create an 
‘wr_addressstall
’ input port.

■ Create an 
‘rd_addressstall’ 
input port.

When you select 
With two read 
/write ports, the 
following options 
are available:

■ Create an 
‘addressstall_a’ 
input port.

■ Create an 
‘addressstall_b’ 
input port.

On/Off Off

Specifies whether to create clock 
enables for address registers. 
You can create these ports to act 
as an extra active low clock 
enable input for the address 
registers.

For more information, refer to 
“Address Clock Enable” on 
page 4–12.

Create an ‘aclr’ asynchronous clear for the 
registered ports. On/Off Off

Specifies whether to create an 
asynchronous clear port for the 
registered ports.

For more information, refer to 
“Asynchronous Clear” on 
page 4–14.

More Options

When you select 
With one read port 
and one write port, 
the following 
options are 
available:

■ ‘rdaddress’ port

■ ‘q_b’ port

When you select 
With two read 
/write ports, the 
following options 
are available:

■ ‘q_a’ port

■ ‘q_b’ port

On/Off Off
Specifies whether the ‘raddress’, 
‘q_a’, and ‘q_b’ ports are cleared 
by the aclr port.

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
June 2014 Altera Corporation Internal Memory (RAM and ROM)
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3–10 Chapter 3: Parameter Settings
Parameter Settings: Output 1

When you select With one read port and one 
write port, the following option is available:

How should the q output behave when reading 
a memory location that is being written from 
the other port?

When you select With two read /write ports, 
the following option is available:

How should the q_a and q_b outputs behave 
when reading a memory location that is being 
written from the other port?

Old memory contents 
appear

or 

I do not care

I do not 
care

Specifies the output behavior 
when read-during-write occurs.

Old memory contents appear— 
The RAM outputs reflect the old 
data at that address before the 
write operation proceeds.

I do not care—This option 
functions differently when you 
turn it on depending on the 
following memory block type you 
select:

■ When you set the memory 
block type to Auto, M144K, 
M512, M4K, M9K, M10K, 
M20K or any other block 
RAM, the RAM outputs ‘don't 
care’ or “unknown” values for 
read-during-write operation 
without analyzing the timing 
path.

■ When you set the memory 
block type to MLAB (for 
LUTRAM), the RAM outputs 
‘dont care’ or ‘unknown’ 
values for read-during-write 
operation but analyzes the 
timing path to prevent 
metastability.

For more information, refer to 
“Read-During-Write” on 
page 4–16.

Do not analyze the timing between write and 
read operation. Metastability issues are 
prevented by never writing and reading at the 
same address at the same time.

On/Off Off

Turn on this option when you 
want the RAM to output ‘don’t 
care’ or unknown values for 
read-during-write operation 
without analyzing the timing 
path.

This option is only available for 
LUTRAM and is enabled when 
you set memory block type to 
MLAB.

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
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Parameter Settings: Output 2 (This tab is only available when you select two read/ write ports)

What should the ‘q_a’ output be when reading 
from a memory location being written to?

New data, Old Data New data

Specifies the output behavior 
when read-during-write occurs.

New Data—New data is available 
on the rising edge of the same 
clock cycle on which it was 
written.

Old Data—The RAM outputs 
reflect the old data at that 
address before the write 
operation proceeds.

For more information, refer to 
“Read-During-Write” on 
page 4–16.

What should the ‘q_b’ output be when reading 
from a memory location being written to?

Get x’s for write masked bytes instead of old 
data when byte enable is used On/Off On Turn on this option to obtain ‘X’ 

on the masked byte.

Parameter Settings: Mem Init

Do you want to specify the initial content of 
the memory?

No, leave it blank 

or

Yes, use this file for the 
memory content data

No, leave 
it blank

Specifies the initial content of the 
memory.

To initialize the memory to zero, 
select No, leave it blank.

To use a memory initialization file 
(.mif) or a hexadecimal 
(Intel-format) file (.hex), select 
Yes, use this file for the 
memory content data.

For more information, refer to 
“Power-Up Conditions and 
Memory Initialization” on 
page 4–18.

Table 3–2. RAM:2-Port Parameter Settings

Option Legal Values Default 
values Description
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Table 3–3 lists the parameter settings for the ROM:1-Port.

Table 3–3. ROM:1-Port Parameter Settings

Option Legal Values Default 
values Description

Parameter Settings: General Page

How wide should the ‘q’ output bus be? — 8

Specifies the width of the ‘q’ 
output bus.

For more information, refer to 
“Port Width Configuration” on 
page 4–7.

How many <X>-bit words of memory? — 256 Specifies the number of <X>-bit 
words.

What should the memory block type be? Auto, M4K, M9K, 
M144K, M10K, M20K Auto

Specifies the memory block 
type. The types of memory 
block that are available for 
selection depends on your 
target device.

For more information, refer to 
“Memory Block Types” on 
page 4–4.

Set the maximum block depth to 
Auto, 32, 64, 128, 
256, 512, 1024, 

2048, 4096
Auto

Specifies the maximum block 
depth in words.

For more information, refer to 
“Maximum Block Depth 
Configuration” on page 4–9

What clocking method would you like to use?

Single clock

or

Dual clock: use 
separate ‘input’ and 

‘output’ clocks

Single clock

Specifies the clocking method 
to use.

Single clock—A single clock 
and a clock enable controls all 
registers of the memory block

Dual clock (Input and Output 
clock)—The input clock 
controls the address registers 
and the output clock controls 
the data-out registers. There are 
no write-enable, byte-enable, or 
data-in registers in ROM mode.

For more information, refer to 
“Clocking Modes and Clock 
Enable” on page 4–10.

Parameter Settings: Regs/Clken/Aclrs

Which ports should be registered?

‘q’ output port
On/Off On Specifies whether to register the 

‘q’ output port.

Create one clock enable signal for each clock 
signal. Note: All registered ports are controlled 
by the enable signal(s)

On/Off Off

Specifies whether to turn on the 
option to create one clock 
enable signal for each clock 
signal.
Internal Memory (RAM and ROM) June 2014 Altera Corporation
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More Options

Use clock enable for 
port A input 
registers

On/Off Off Specifies whether to use clock 
enable for port A input registers.

Use clock enable for 
port A output 
registers

On/Off Off
Specifies whether to use clock 
enable for port A output 
registers.

Create an 
‘addressstall_a’ 
input port.

On/Off Off

Specifies whether to create a 
addressstall_a input port. 
You can create this port to act 
as an extra active low clock 
enable input for the address 
registers.

For more information, refer to 
“Address Clock Enable” on 
page 4–12.

Create an ‘aclr’ asynchronous clear for the 
registered ports. On/Off Off

Specifies whether to create an 
asynchronous clear port for the 
registered ports.

For more information, refer to 
“Asynchronous Clear” on 
page 4–14.

More Options

‘address’ port On/Off Off
Specifies whether the ‘address’ 
port should be affected by the 
‘aclr’ port.

‘q’ port On/Off Off
Specifies whether the ‘q’ port 
should be affected by the ‘aclr’ 
port.

Create a ‘rden’ read enable signal On/Off Off

Specifies whether to create a 
read enable signal.

For more information, refer to 
“Read Enable” on page 4–15.

Parameter Settings: Mem Init

Do you want to specify the initial content of the 
memory?

Yes, use this file for 
the memory content 

data

Yes, use 
this file for 
the memory 
content data

Specifies the initial content of 
the memory.

In ROM mode you must specify 
a memory initialization file 
(.mif) or a hexadecimal 
(Intel-format) file (.hex). The 
Yes, use this file for the 
memory content data option is 
turned on by default.

For more information, refer to 
“Power-Up Conditions and 
Memory Initialization” on 
page 4–18.

Table 3–3. ROM:1-Port Parameter Settings

Option Legal Values Default 
values Description
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Table 3–4 lists the parameter settings for the ROM:2-Port.

Allow In-System Memory Content Editor to 
capture and update content independently of the 
system clock

On/Off Off

Specifies whether to allow 
In-System Memory Content 
Editor to capture and update 
content independently of the 
system clock

The ‘Instance ID’ of this ROM is — None Specifies the ROM ID.

Table 3–3. ROM:1-Port Parameter Settings

Option Legal Values Default 
values Description

Table 3–4. ROM:2-Port Parameter Settings

Option Legal Values Default 
values Description

Parameter Settings: Widths/Blk Type

How do you want to specify the memory size?

As a number of words

or

As a number of bits

As a number 
of words

Determines whether to specify 
the memory size in words or 
bits.

How many <X>-bit words of memory?

32, 64, 128, 256, 
512, 1024, 2048, 

4096, 8192, 16384, 
32768, 65536

256 Specifies the number of <X>-bit 
words.

Use different data widths on different ports On/Off Off

Specifies whether to use 
different data widths on different 
ports.

For more information, refer to 
“Mixed-width Port 
Configuration” on page 4–8.

How wide should the ‘q_a’ output bus be?

— 8

Specifies the width of the ‘q_a’ 
and ‘q_b’ output ports.

For more information, refer to 
“Port Width Configuration” on 
page 4–7.

How wide should the ‘q_b’ output bus be?

What should the memory block type be?
Auto, M4K, M9K, 
M144K, M10K, 
M20K, MLAB

Auto

Specifies the memory block 
type. The types of memory block 
that are available for selection 
depends on your target device

For more information, refer to 
“Memory Block Types” on 
page 4–4.

Set the maximum block depth to Auto, 128, 256, 512, 
1024, 2048, 4096 Auto

Specifies the maximum block 
depth in words. This option is 
enabled only when you choose 
Auto as the memory block type.

For more information, refer to 
“Maximum Block Depth 
Configuration” on page 4–9.
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Parameter Settings: Clks/Rd, Byte En

What clocking method would you like to use?

Single clock 

or

Dual Clock: use 
separate ‘input’ and 

‘output’ clocks

or

Dual clock: use 
separate clocks for A 

and B ports

Single clock

Specifies the clocking method to 
use.

Single clock—A single clock 
and a clock enable controls all 
registers of the memory block

Dual Clock: use separate ‘input’ 
and ‘output’ clocks—The input 
clock controls the address 
registers and the output clock 
controls the data-out registers. 
There are no write-enable, 
byte-enable, or data-in registers 
in ROM mode.

Dual clock: use separate clocks 
for A and B ports—Clock A 
controls all registers on the port 
A side; clock B controls all 
registers on the port B side. 
Each port also supports 
independent clock enables for 
both port A and port B registers, 
respectively.

For more information, refer to 
“Clocking Modes and Clock 
Enable” on page 4–10.

Create a ‘rden_a’ and ‘rden_b’ read enable 
signals — Off

Specifies whether to create read 
enable signals.

For more information, refer to 
“Read Enable” on page 4–15.

Parameter Settings: Regs/Clkens/Aclrs

Read output port(s) ‘q_a’ and ‘q_b’ On/Off On Specifies whether to register the 
‘q_a’ and ‘q_b’ output ports.

More Options
‘q_a’ port On/Off On Specifies whether to register the 

‘q_a’ output port.

‘q_b’ port On/Off On Specifies whether to register the 
‘q_b’ output port.

Create one clock enable signal for each clock 
signal. On/Off Off

Specifies whether to turn on the 
option to create one clock enable 
signal for each clock signal.

Table 3–4. ROM:2-Port Parameter Settings

Option Legal Values Default 
values Description
June 2014 Altera Corporation Internal Memory (RAM and ROM)
User Guide



3–16 Chapter 3: Parameter Settings
More Options

Use clock enable for 
port A input registers On/Off Off Specifies whether to use clock 

enable for port A input registers.

Use clock enable for 
port A output 
registers

On/Off Off
Specifies whether to use clock 
enable for port A output 
registers.

Create an 
‘addressstall_a’ input 
port.

On/Off Off

Specifies whether to create 
addressstall_a and 
addressstall_b input ports. 
You can create these ports to act 
as an extra active low clock 
enable input for the address 
registers.

For more information, refer to 
“Address Clock Enable” on 
page 4–12.

Create an 
‘addressstall_b’ 
input port.

Create an ‘aclr’ asynchronous clear for the 
registered ports. On/Off Off

Specifies whether to create an 
asynchronous clear port for the 
registered ports.

For more information, refer to 
“Asynchronous Clear” on 
page 4–14.

More Options

‘q_a’ port On/Off Off
Specifies whether the ‘q_a’ port 
should be cleared by the aclr 
port.

‘q_b’ port On/Off Off
Specifies whether the ‘q_b’ port 
should be cleared by the aclr 
port.

Parameter Settings: Mem Init

Do you want to specify the initial content of the 
memory?

Yes, use this file for 
the memory content 

data

Yes, use 
this file for 
the memory 
content data

Specifies the initial content of 
the memory.

In ROM mode you must specify 
a memory initialization file (.mif) 
or a hexadecimal (Intel-format) 
file (.hex). The Yes, use this file 
for the memory content data 
option is turned on by default.

For more information, refer to 
“Power-Up Conditions and 
Memory Initialization” on 
page 4–18.

The initial content file should conform to which 
port’s dimensions?

PORT_A 

or

PORT_B

PORT_A
Specifies whether the initial 
content file conforms to port A 
or port B.

Table 3–4. ROM:2-Port Parameter Settings

Option Legal Values Default 
values Description
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4. Functional Description
This section describes the features and functionality of the internal memory blocks 
and the ports of the ALTSYNCRAM and ALTDPRAM IP cores.

Memory Modes Configuration
A memory block contains two address ports (port A and port B) with their respective 
output data ports, and you can use them for read and write operations depending on 
the memory mode you choose. The input and output ports shown in the block 
diagrams refer to the ports of the wrapper that contains the memory IP core 
instantiated in it. The ports of the wrapper are mapped to the ports of either the 
ALTSYNCRAM or the ALTDPRAM IP core depending on your memory 
configuration, and the port name reflects the memory features you create. For 
example, the name of the wrapper port clockena maps to the clock_enable_input_a 
port of the ALTSYNCRAM IP core, which relates to the clock enable feature.

For more information about the ports of the ALTSYNCRAM and ALTDPRAM IP 
cores, refer to “ALTSYNCRAM and ALTDPRAM Ports” on page 4–20.

Single-port RAM
In a single-port RAM, the read and write operations share the same address at port A, 
and the data is read from output port A. 

Figure 4–1 shows a block diagram of a typical single-port RAM.

Figure 4–1.  Single-port RAM
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Memory Modes Configuration
Simple Dual-port RAM
In simple dual-port RAM mode, a dedicated address port is available for each read 
and write operation (one read port and one write port). A write operation uses write 
address from port A while read operation uses read address and output from port B.

Figure 4–2 shows the block diagram of a simple dual-port RAM.

True Dual-port RAM
In true dual-port RAM mode, two address ports are available for read or write 
operation (two read/write ports). In this mode, you can write to or read from the 
address of port A or port B, and the data read is shown at the output port with respect 
to the read address port.

Figure 4–3 shows the block diagrams of a true dual-port RAM.

Figure 4–2.  Simple Dual-Port RAM
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Figure 4–3.  True Dual-port RAM

data_a[] data_b[]

address_a[] address_b[]

wren_a wren_b

byteena_a[] byteena_b[]

addressstall_a

clock_a

aclr_a

q_a[]

rden_b

aclr_b

q_b[]

rden_a

clock_b

addressstall_b
Internal Memory (RAM and ROM) June 2014 Altera Corporation
User Guide



Chapter 4: Functional Description 4–3
Memory Modes Configuration
Single-port ROM
In single-port ROM, only one address port is available for read operation. 

Figure 4–4 shows the block diagram of a single-port ROM. 

Dual-port ROM
The dual-port ROM has almost similar functional ports as single-port ROM. The 
difference is dual-port ROM has an additional address port for read operation.

Figure 4–5 shows the block diagram of a dual-port ROM. 

Figure 4–4.  Single-port ROM
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Figure 4–5.  Dual-port ROM
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Memory Block Types
Memory Block Types
Altera provides various sizes of embedded memory blocks for various devices. The 
parameter editor allows you to implement your memory in the following ways:

■ Select the type of memory blocks available based on your target device. Refer to 
Table 4–1 on page 4–5. To select the appropriate memory block type for your 
device, obtain more information about the features of your selected internal 
memory block in your target device, such as the maximum performance, 
supported configurations (depth × width), byte enable, power-up condition, and 
the write and read operation triggering.

■ Use logic cells. As compared to internal memory resources, using logic cells to 
create memory reduces the design performance and utilizes more area. This 
implementation is normally used when you have used up all the internal memory 
resources. When logic cells are used, the parameter editor provides you with the 
following two types of logic cell implementations:

■ Default logic cell style—the write operation triggers (internally) on the rising 
edge of the write clock and have continuous read. This implementation uses 
less logic cells and is faster, but it is not fully compatible with the Stratix M512 
emulation style.

■ Stratix M512 emulation logic cell style—the write operation triggers 
(internally) on the falling edge of the write clock and performs read only on the 
rising edge of the read clock. 

■ Select the Auto option, which allows the software to automatically select the 
appropriate internal memory resource. When you set the memory block type to 
Auto, the compiler favors larger block types that can support the memory capacity 
you require in a single internal memory block. This setting gives the best 
performance and requires no logic elements (LEs) for glue logic. When you create 
the memory with specific internal memory blocks, such as M9K, the compiler is 
still able to emulate wider and deeper memories than the block type supported 
natively. The compiler spans multiple internal memory blocks (only of the same 
type) with glue logic added in the LEs as needed.

1 To obtain proper implementation based on the memory configuration you 
set, allow the Quartus II software to automatically choose the memory type. 
This gives the compiler the flexibility to place the memory function in any 
available memory resources based on the functionality and size. 
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Memory Block Types

)

Logic 
Cell 
(LC)

v

v

v

v

v

v

v

v

e.
Table 4–1 lists the options available for you to implement your memory blocks in 
various device families.

1 To identify the type of memory block that the software selects to create your memory, 
refer to the fitter report after compilation.

f For more information about internal memory blocks and the specifications, refer to 
the memory related chapters in your target device handbook.

Table 4–1.  Internal Memory Blocks in Altera Devices

Device Family

Memory Block Types

M512 (1)

(512 bits)
M4K

(4 Kbits)
M-RAM (2)

(512 Kbits)
MLAB(640

bits)
M9K

(9 Kbits)
M144K

(144 Kbits)
M10K

(10 Kbits)
M20K

(20 Kbits

Arria II GX — — — v v — — —

Arria II GZ — — — v v v — —

Arria V — — — v — — v —

Cyclone IV — — — — v — — —

Cyclone V — — — v — — v —

Max II — — — — — — — —

Stratix IV — — — v v v — —

Stratix V — — — v — — — v

Notes to Table 4–1:

(1) M512 blocks are not supported in true dual-port RAM mode, and dual-port ROM mode
(2) M-RAM blocks are not supported in ROM mode.
(3) MLAB blocks are not supported in simple dual-port RAM mode with mixed-width port feature, true dual-port RAM mode, and dual-port ROM mod
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Write and Read Operations Triggering
Write and Read Operations Triggering
The internal memory blocks vary slightly in its supported features and behaviors. 
One important variation is the difference in the write and read operations triggering.

Table 4–2 lists the write and read operations triggering for various internal memory 
blocks.

It is important that you understand the write operation triggering to avoid potential 
write contentions that can result in unknown data storage at that location.

Table 4–2.  Write and Read Operations Triggering for internal Memory Blocks

internal Memory Blocks Write Operation (1) Read Operation

M10K Rising clock edges Rising clock edges

M20K Rising clock edges Rising clock edges

M144K Rising clock edges Rising clock edges

M9K Rising clock edges Rising clock edges

MLAB
Falling clock edges

Rising clock edges (in Arria V, Cyclone V, 
and Stratix V devices only)

Rising clock edges (2)

M-RAM Rising clock edges Rising clock edges

M4K Falling clock edges Rising clock edges

M512 Falling clock edges Rising clock edges

Notes to Table 4–2:

(1) Write operation triggering is not applicable to ROMs.
(2) MLAB supports continuos reads. For example, when you write a data at the write clock rising edge and after the 

write operation is complete, you see the written data at the output port without the need for a read clock rising edge.
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Port Width Configuration
Figure 4–6 and Figure 4–7 show the valid write operation that triggers at the rising 
and falling clock edge, respectively. 

Figure 4–6 assumes that twc is the maximum write cycle time interval. Write operation 
of data 03 through port B does not meet the criteria and causes write contention with 
the write operation at port A, which result in unknown data at address 01. The write 
operation at the next rising edge is valid because it meets the criteria and data 04 
replaces the unknown data. 

Figure 4–7 assumes that twc is the maximum write cycle time interval. Write operation 
of data 04 through port B does not meet the criteria and therefore causes write 
contention with the write operation at port A that result in unknown data at address 
01. The next data (05) is latched at the next rising clock edge that meets the criteria and 
is written into the memory block at the falling clock edge.

1 Data and addresses are latched at the rising edge of the write clock regardless of the 
different write operation triggering.

Port Width Configuration
The port width configuration is defined by the following equation: 

Memory depth (number of words) × Width of the data input bus

f For more information about the supported port width configuration for various 
internal memory blocks, refer to the memory related chapters in your target device 
handbook.

Figure 4–6. Valid Write Operation that Triggers at Rising 
Clock Edges

Figure 4–7. Valid Write Operation that Triggers at Falling 
Clock Edge
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Mixed-width Port Configuration
If your port width configuration (either the depth or the width) is more than the 
amount an internal memory block can support, additional memory blocks (of the 
same type) are used. For example, if you configure your M9K as 512 × 36, which 
exceeds the supported port width of 512 × 18, two M9Ks are used to implement your 
RAM. 

In addition to the supported configuration provided, you can set the memory depth 
to a non-power of two, but the actual memory depth allocated can vary. The variation 
depends on the type of resource implemented. 

If the memory is implemented in dedicated memory blocks, setting a non-power of 
two for the memory depth reflects the actual memory depth. If the memory is 
implemented in logic cells (and not using Stratix M512 emulation logic cell style that 
can be set through the parameter editor), setting a non-power of two for the memory 
depth does not reflect the actual memory depth. In this case, you write to or read from 
up to 2 address_width memory locations even though the memory depth you set is less 
than 2 address_width . For example, if you set the memory depth to 3, and the RAM is 
implemented using logic cells, your actual memory depth is 4. 

When you implement your memory using dedicated memory blocks, you can check 
the actual memory depth by referring to the fitter report.

Mixed-width Port Configuration
Only dual-port RAM and dual-port ROM support mixed-width port configuration for 
all memory block types except when they are implemented with LEs. The support for 
mixed-width port depends on the width ratio between port A and port B. In addition, 
the supporting ratio varies for various memory modes, memory blocks, and target 
devices.

1 MLABs do not have native support for mixed-width operation, thus the 
option to select MLABs is disabled in the parameter editor. However, the 
Quartus II software can implement mixed-width memories in MLABs by 
using more than one MLAB. Therefore, if you select AUTO for your 
memory block type, it is possible to implement mixed-width port memory 
using multiple MLABs. 

f For more information about width ratio that supports mixed-width port, 
refer to your relevant device handbook.

Memory depth of 1 word is not supported in simple dual-port and true dual-port 
RAMs with mixed-width port. The parameter editor prompts an error message when 
the memory depth is less than 2 words. For example, if the width for port A is 4 bits 
and the width for port B is 8 bits, the smallest depth supported by the RAM is 4 
words. This configuration results in memory size of 16 bits (4 × 4) and can be 
represented by memory depth of 2 words for port B. If you set the memory depth to 2 
words that results in memory size of 8 bits (2 × 4), it can only be represented by 
memory depth of 1 word for port B, and therefore the width of the port is not 
supported.
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Maximum Block Depth Configuration
Maximum Block Depth Configuration
You can limit the maximum block depth of the dedicated memory block you use. The 
memory block can be sliced to your desired maximum block depth. For example, the 
capacity of an M9K block is 9,216 bits, and the default memory depth is 8K, in which 
each address is capable of storing 1 bit (8K × 1). If you set the maximum block depth 
to 512, the M9K block is sliced to a depth of 512 and each address is capable of storing 
up to 18 bits (512 × 18). 

You can use this option to save power usage in your devices. However, this parameter 
might increase the number of LEs and affects the design performance.

When the RAM is sliced shallower, the dynamic power usage decreases. However, for 
a RAM block with a depth of 256, the power used by the extra LEs starts to outweigh 
the power gain achieved by shallower slices.

You can also use this option to reduce the total number of memory blocks used (but at 
the expense of LEs). The 8K × 36 RAM uses 36 M9K RAM blocks with a default slicing 
of 8K × 1. By setting the maximum block depth to 1K, the 8K × 36 RAM can fit into 32 
M9K blocks.

The maximum block depth must be in a power of two, and the valid values vary 
among different dedicated memory blocks.
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Clocking Modes and Clock Enable
Table 4–3 lists the valid range of maximum block depth for various internal memory 
blocks.

The parameter editor prompts an error message if you enter an invalid value for the 
maximum block depth. Altera recommends that you set the value to Auto if you are 
not sure of the appropriate maximum block depth to set or the setting is not important 
for your design. This setting enables the compiler to select the maximum block depth 
with the appropriate port width configuration for the type of internal memory block 
of your memory. 

Clocking Modes and Clock Enable
Altera internal memory supports various types of clocking modes depending on the 
memory mode you select.

Table 4–4 lists the internal memory clocking modes.

1 Asynchronous clock mode is only supported in MAX series of devices, and not 
supported in Stratix and newer devices. However, Stratix III and newer devices 
support asynchronous read memory for simple dual-port RAM mode if you choose 
MLAB memory block with unregistered rdaddress port.

1 The clock enable signals are not supported for write address, byte enable, and data 
input registers on Arria V, Cyclone V, and Stratix V MLAB blocks.

Table 4–3.  Valid Range of Maximum Block Depth for Various internal Memory Blocks

internal Memory Blocks Valid Range (1)

M10K 256–8K

M20K 512–16K

M144K 2K–16K

M9K 256–8K

MLAB 32–64 (2)

M512 32–512

M4K 128–4K

M-RAM 4K–64K

Notes to Table 4–3:

(1) The maximum block depth must be in a power of two.
(2) The maximum block depth setting (64) for MLAB is not available for Arria V and Cyclone V devices.

Table 4–4.  Clocking Modes

Clocking Modes Single-port RAM Simple Dual-port RAM True Dual-port 
RAM

Single-port 
ROM

Dual-port 
ROM

Single clock v v v v v

Read/Write — v — — —

Input/Output v v v v v

Independent — — v — v
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Clocking Modes and Clock Enable
Single Clock Mode
In the single clock mode, a single clock, together with a clock enable, controls all 
registers of the memory block. 

Read/Write Clock Mode
In the read/write clock mode, a separate clock is available for each read and write 
port. A read clock controls the data-output, read-address, and read-enable registers. A 
write clock controls the data-input, write-address, write-enable, and byte enable 
registers.

Input/Output Clock Mode
In input/output clock mode, a separate clock is available for each input and output 
port. An input clock controls all registers related to the data input to the memory 
block including data, address, byte enables, read enables, and write enables. An 
output clock controls the data output registers. 

Independent Clock Mode
In the independent clock mode, a separate clock is available for each port (A and B). 
Clock A controls all registers on the port A side; clock B controls all registers on the 
port B side.

1 You can create independent clock enable for different input and output registers to 
control the shut down of a particular register for power saving purposes. From the 
parameter editor, click More Options (beside the clock enable option) to set the 
available independent clock enable that you prefer.
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Address Clock Enable
Address Clock Enable
The address clock enable (addressstall) port is an active high asynchronous control 
signal that holds the previous address value for as long as the signal is enabled. When 
the memory blocks are configured in dual-port RAMs or dual-port ROMs, you can 
create independent address clock enable for each address port.

To configure the address clock enable feature, click More Options located beside the 
clock enable option on the parameter editor. Turn on Create an ‘addressstall_a’ input 
port or Create an ‘addressstall_b’ input port to create an addressstall port.

Figure 4–8 and Figure 4–9 show the results of address clock enable signal during the 
read and write operations, respectively.

Figure 4–8.  Address Clock Enable During Read Operation

Figure 4–9.  Address Clock Enable During Write Operation
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